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About PPCUG
Coming Events

General Meetings
Second Monday of the month at the
Lawrenceville Library.
Route 1 and Darrah Lane.
7:00-7:45 PM: Social Time / Tech Corner
7:45 PM: Meeting Comes to Order
8 PM: Featured Presentation
For information about upcoing meetings or
joining PPCUG call 908-218-0778 to leave a
message.

January 13, 2003 - PowerPoint - It’s Easy to Use!
Paul Kurivchack will demonstrate some tips & tricks in using PowerPoint to make
thosegreat looking presentations..

February 10, 2003 - Buy & Sell on Ebay!
Martin Masho will host the evenings presentation on the ins and out of buying and
selling anything on Ebay or any auction site.

March 10, 2003 - to be announced

Board Meetings
For Meeting Location, Date and Time, call
908-218-0778
Board meetings are open to All.

Presidents Message
by Paul Kurivchack

Board Members
President:
Paul Kurivchack ........... 908-218-0778
Vice-President:
Tom Carman ................. 732-828-6055
Secretary:
Don Arrowsmith ........... 609-883-9874
Treasurer:
Tom Carman ................. 732-828-6055
Members-At-Large:
Jon Abolins .................. 609-883-8126
Vic Laurie ..................... 609-924-1220
Kim Goldenberg ........... 609-671-9188
Sol Libes ...................... 609-520-9024

2002 is coming to a close, as is my presidency of the past seven years.
As I look back over the past twelve years of my involvement with the
group, I still remember it like yesterday, attending my very first meeting back in 1990 at the insistence of my friend, Steve Shaw (Steve was President in
1991).
I was in awe of the technical skills of the members in attendance at that meeting and
I wondered if I would ever have that level of knowledge? Well I have learned a lot from
our meetings, our members and I continue to learn as I hope you do too. I do not think
I will ever stop learning and I think that this is one of the greatest strengths of a user
group, the continuing education on using personal computers.

Chairpersons
Hospitality:
Bill Hawryluk ................ 609-655-0923
Member Records:
Paul Kurivchack ........... 908-218-0778
Newsletter Editor:
Paul Kurivchack ........... 908-218-0778
Program Coordinator:
Sol Libes ...................... 609-520-9024
Web Master:
Jon Abolins .................. 609-883-8126

Web Site

We have had and continue to have a great diverse group of people attending our
meetings from all walks of live and computing skill levels. We need to continue to
learn and to have a warm, friendly atmosphere where everyone is welcomed. That is
the one thing I still remember from that very first night. I was made to feel right at
home despite being a very novice PC user.
Do you remember attending your very first PPCUG meeting? If you do, please email
me a short twenty-five words more or less of the month and year and what you remember about the first night. I will comprise them over the next couple of months and put
them in a future newsletter. This is not only for long time members but for new members too.

http://www.ppcug-nj.org

Annual Dues Rates
Normal dues rate is $30 per year.
New Members Only: after February, the
rate is $2.50 per month times the number of
months remaining in the year.
PublishedMonthly by:Princeton PC Users Group
PO Box 291 Rocky Hill, NJ 08553
© Copyright 2002 December 2002 Vol. 18 No. 12
The reprinting of original material appearing in this
newsletter in any other publication must credit the
Princeton PC Users Group Newsletter and/or the
Princeton PC Users Group and any authors
shown. The editor and the Princeton PC Users
Group assume no responsibility or liability for
damages arising from the publication or nonpublication of any article in this newsletter.
Opinions expressed in these articles are not
necessarily those of the members of the Princeton
PC Users Group.
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It has been a great seven years of being president of the group and I look forward to
helping Clarke Walker make the transition to being the eight PPCUG president in the
history of the group. Let us all help Clarke make the PPCUG a great group to share
ideas and learn about personal computers.
I also want to thank Karl Juelch for the fine presentation on Print Artist. There are
many programs we use daily that may not be as mainstream as the Microsoft’s of the
world but still provide the results that make us all productive. Karl’s presentation proved
how useful and easy to use a product like Print Artist can be. Karl also demonstrated
that getting up in front of the group is not that hard either. Thanks Karl.
I look forward to seeing you all at the Holiday Party & Elections on December 8th.
PS: Remember we have a box full of MS software and other items to raffle off.
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More Windows XP Tweaks
By: Vic Laurie - PPCUG
In this article we continue the discussion of Windows XP
tweaks begun last month. Once more, I remind you that not all
systems behave the same way and that “your mileage may vary.”
Also never tweak without first knowing how to get back where
you started.

Show All Files and Folders
Microsoft hides a lot of things in the default operating system
settings for XP (as they did for Win 9X/Me). This may make
sense in a multi-user office environment with many computers
but it is a distinct annoyance for the home user who wants some
control over his or her computer. The default setting of hiding
file extensions, for example, just makes life more difficult. For a
number of reasons, I have always suggested that these settings
be changed. Go to My Computer (or any folder window) and
open the “Tools” menu. Select “Folder Options” from the list
and click the “View” tab. In the list in the area headed by “Advanced settings” (Figure 1) make these changes:
Check “Display the contents of system folders”
Check “Show hidden files and folders”
Uncheck “Hide extensions for known file types”
Uncheck “Hide protected operating system files.”

Figure 2. Search Companion panel

Protect Your Privacy from Media Player
This tweak applies not only to Windows XP but also to all
systems with Media Player 7.1 and later versions. When you
play streamed clips from an Internet site, Media Player sends
that site a number specific to your machine called a “globally
unique identifier” or GUID. To turn this off, open Media Player
and go to the Tools menu. In the Tools menu select “Options”
and then the “Player” tab. (Figure 3) In the “Internet settings”
area, uncheck “Allow Internet sites to uniquely identify your
Player.” While you are there also uncheck “Acquire licenses
automatically.”

Figure 1. File and folder settings

A Dog of a Feature
For whatever reason, Microsoft is enamored of animated figures. (Remember Bob?) I have never liked the notorious animated paper clip in Office (which Microsoft finally killed) and
I don’t really need the cute little dog that has been added to the
search function in XP. I love dogs, but not here. If you want this
pup to help retrieve your files, fine, but otherwise go to StartSearch and in the panel called “Search Companion” (Figure 2)
click “Change preferences” and then select “Without an animated screen character.
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Figure 3. Media Player settings

References
Additional tweaking possibilities can be found in these references:
http://www.techspot.com/guides-os.shtml

http://www.ppcug-nj.org

More Windows XP Tweaks continued on page 5
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Time to Consider a Notebook (Laptop) Computer?
By: Ira Wilsker
One of the questions I often have been asked on my weekly
radio shows, and emails from readers of this column is, “What
would be better (for me); a new laptop or a desktop computer?”
A simple review of the Sunday sale-books from the major office supply and electronics stores clearly shows that there is an
abundant supply of notebook computers available. Standing in
the security lines at the major airports also shows the popularity
of notebook computers.
So, which one is better? Desktop or notebook? As I have
consistently replied, “What are you going to use it for?”
If a computer is intended for home or office use, likely in one
location for a period of time, a desktop computer is more practical. Usability features, such as a full size keyboard, large screen
monitor, and readily accessible drives, coupled with significantly lower prices for comparable machines, make the desktop the
clear choice in this scenario. Another factor is longevity. The
average useful life of a desktop computer, according to both personal experience and published reports, is typically four to six
years. Desktop computers are also usually easy and relatively
inexpensive to upgrade or repair. The average desktop computer becomes functionally obsolete long before it physically fails.
Notebook computers, commonly called “laptops” by many,
have some very strong advantages, compared to desktop computers, as well as some very strong disadvantages. The obvious
advantage of a notebook computer is portability. At Golden
Triangle PC Club meetings, when I would have to present, I
would often have to drag my desktop from home to the meeting
place; it was heavy, bulky, and easy to break. Lugging around
the computer, monitor, keyboard, and mouse was a headache. I
was not the only one hauling a monster around. For a while, I
had a “lunchbox” computer that I used for my presentations. It
contained a standard sized PC motherboard, hard drive, floppy,
and other internal parts, along with an integral 7" monitor. The
keyboard snapped over the front of the computer, closing it.
While mine was a home built, no-name generic, it was the early
lunchbox computers that gave Houston’s Compaq its early competitive edge. While still large and heavy, it was portable.
Today’s notebook computers are a far cry from my long-gone
lunchbox. They are a fraction of the size and weight of the old
lunchbox machines, but contrary to other high-tech electronic
items, have not dropped substantially in price. Feature for feature, it is not rare for a notebook to be twice the price of a
comparably equipped desktop computer. The relatively small
size, and lightweight is what makes today’s notebook computer
popular. They are convenient portable, and can often run for a
few hours on their internal battery, but those are about their
only major advantages. For those who need portability, such as
businesspersons who travel and need computing power, or people like me who frequently do presentations, a notebook computer is a near necessity. For those who want the power of a
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modern PC, in an even smaller and lighter package, the next
generation of “Pocket PCs” is speculated to do to the contemporary notebook the same thing that the notebook did to the lunchbox; render them functionally obsolete. Pocket PCs will be covered in a future column.
The disadvantages of a notebook computer are many, yet still
they are a necessity to many users. Other than their relatively
high cost, notebook computers are also typically fragile, difficult to repair, hard to upgrade (other than swap hard drives or
add memory), and according to widely published tests, have a
much shorter operational lifetime than do desktop computers.
Notebooks are also subject to easy loss or theft. In a recent news
article, citing a report from Safeware, an insurance company
that specifically insures computers for loss or damage, notebook
computers have a far higher rate of loss. In 2001, for example,
Safeware states that an estimated 600,000 notebook computers
were lost or stolen, up 53% from the year 2000. A large part of
this increase is due to the rapid increase in sales of notebook
computers. Notebook computers are also one of the most obvious items to steal (and stolen) at airport security checkpoints,
due to their small size, high value, and obvious nature. By comparison, while there is an estimated seven times as many desktop computers in use than notebooks, only 15,000 desktops were
reported stolen in 2001, according to Safeware.
While there are “ruggedized” notebook computers, such as
Toshiba’s Toughbook series marketed to law enforcement, utility, and construction companies, the majority of notebooks are
very easy to break, and expensive to repair. The notebook reviews published in the major computer magazines often include
a “drop test” where an open notebook computer was gently
pushed off a tabletop on to a carpeted floor, simulating a common falling accident. Many notebooks suffered major physical
damage, with some models of major brands shattering to utter
destruction. In addition to extraordinary care in protecting from
theft, notebook computers must also be transported in quality
protective cases. I have seen people ruin a $2000 notebook in a
$29 carry case, a false economy. Screens are especially sensitive
to physical shock, can easily crack, and cost several hundreds of
dollars to replace.
Lacking a large physical volume to circulate cooling air while
turned on; notebook computers are more vulnerable to heat damage than desktops. Often containing only tiny cooling fans, and
using the notebook itself as a heat sink, overheating is the principle cause of internal notebook failure. The more powerful the
processor, the more prone the notebook is to overheating, a welldocumented problem. I have heard several anecdotal stories of
fairly new notebooks failing when left on overnight, due to overheating. I recently replaced my oldest daughter’s notebook due
to that exact cause. Published reports indicate that the average
life expectancy of a notebook computer is only about 18 months,
before it is lost, stolen, accidentally broken, overheated, or worn
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Buying a DVD Recorder
By: Bob Elgines
Well the prices are coming down, now under $300 and as low
as $220, for a DVD recorder. The blank disks are now under
$2.50 each in lots of ten or more. But beware, the great decision
as to which format is still under debate, DVD-R or DVD+R! If
you just wish to make videos either one should work in most
DVD players made after the year 2000, but not all. Cheaper
DVDR disks and players will not work.
Support out there is very weak to almost NONE! Much time
is needed to be invested like 4 to 10 hours to make a 2 hour
video DVD, of which several programs require you to sit in front
of your computer.
Most of the software is over priced and does not work without
many problems and no support like “Video Studio 6” by Cyber.
The best so far has been “MyDVD” by Sonic. Some of the suggestions listed below came from them.
The best input devices are: “USB Instant DVD” by ADS
($160), “Bungee DVD” by Pinnacle ($150), “DCS 100” ($170)
and “DCS 200” by Dazzle ($230). They all come with software
that have individual problems, and advertise “Fast, Easy & Fun”,
boy that is a huge JOKE! It’s Slow, Hard, & Will drive you nuts.

*You have at least 21 gigs available on a single drive
*You have the latest drivers for the following: DVD Rom,
burner, CD-ROM and burner.
*Your hard drives have been defragmented.
*In particular, while capturing video, do not use your PC for
any other activity. Video capture requires all your PC’s processing power, and any action such as inserting a disc or receiving email may cause errors in the captured video files.
*Your monitor resolution must be set to 1024x768 16 or 32
bit color
*You are running ASPI driver 4.6. No higher, no lower. If you
are unsure, you can go here to find out and/or download the
appropriate driver: http://aspi.radified.com
*You are not running you machine/session of a network/RAID
configuration
*Make sure you have the latest version DirectX (a must), WMP
(a must):
*If your “Input digital device” is on USB, then remove all
other USB external equipment.
*You may also find it beneficial to enable DMA for all your
drives.
There are DVD-RAM and DVD+RAM which allows you to
save up to 9.6GB of Data, but hard drives are much cheaper,
like 20GB for $69.00 or lower. It is just not FAST and EASY as
they have stated in their advertising!
Bob Elgines can be reached by email: elginesz@rraz.net

If you can not provide all of the suggestions (really necessary
evils) below then don’t get involved. I became one of their guinea
pig and I am about to throw it all in the circle file and call it a
lost.
My ASUS computer is an Intel P3 @ 866MHz, 256MB RAM
@ 133MHz, 60GB Hard Drive @ 7200rpm ATA100, ATI Radeon 32MB video card, with the “USB Instant DVD” input device
(I tried out the DAZZLE equipment, but it had big noise problems and they had NO support at all), VIVASTAR (LF311)
DVD-R recorder. I have tried two operating systems such as Win
’98SE and Win’ME and saw no difference, went back to
Win’98SE.
For Windows ’98 ‘XP users start off with these suggestions on
getting ready to record a DVD:
*Install at least 256 MB of RAM
*Disable the Screen Saver
*Disable the Turn off Hard Disks option
*Disable the Hibernation option
*Disable the Network Time Server (Win’XP)
*Disable Text to Speech (Win’XP)
*Disable any scheduled tasks (for example, virus scan)
*Do not increase Virtual Memory beyond Windows’ recommended setting
*Close any other running applications
*Do not copy any large files while capturing
*Do not allow any remote activities, such as PC Anywhere or
Timbuktu connections
*Your hard drives are formatted to NTFS (which as no files
size limitations Win’XP)
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This article is brought to you by the Editorial Committee of
the Association of Personal Computer User Groups (APCUG),
an International organization to which this user group belongs.

More Windows Tweaks continued from page 3

http://www.tweakxp.com/tweakxp/
http://www.kellys-korner-xp.com/xp.htm
http://www.dougknox.com/
http://www.onecomputerguy.com/windowsxp_tips.htm
http://members.fortunecity.com/computingx/
xptweakguide.htm
http://www.winsupersite.com/showcase/windowsxp_tips.asp
http://www.windows-help.net/WindowsXP/cust-idx.html
http://www.extremetech.com/article2/0,,5155,00.asp
http://www.extremetech.com/article2/0,3973,550842,00.asp
http://www.pcmag.com/article2/0,4149,570867,00.asp

http://www.ppcug-nj.org
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Recycle your Old Equipment
By: Don Arrowsmith - PPCUG
All of us outgrow our computers at some point or other. Rather
than pile it up at the curb or stuff it in the back corner of the
basement for your children to dispose of, why not take it to the
Trenton Materials Exchange. They are located just off Route
One and will be happy to accept your old computer and other
electronic items, including CPUs, modems, cables, answering
machines, VCRs, projectors, telephones, typewriters, monitors,
terminals, CRTs, TVs. Note: There is a $5 handling fee for
each computer monitor or TV monitor to assist with lead &
glass disposal fees. They don’t accept microwave ovens! Newer
equipment may be refurbished and passed along to a worth cause.
If the equipment is truly trash, it will be remanufactured by a
properly licensed firm. They are a 501(c)3 organization and will
provide you with a receipt for tax purposes. For more information see http://www.tmex.org/computer.htm.
If you have an old wireless phone that’s gathering dust, there
are several groups that will accept them and reprogram working
units to dial only 911 to be passed along to, e.g., abused women.
One group is the Donate a Phone project of the Wireless Foundation named:
CALL to PROTECT. Contact at web site:
(http://www.wirelessfoundation.org/12give/index2.cfm), which
redistributes phones free of charge to victims in need. Phones
with batteries, chargers and manuals can be mailed to Motorola
(see web site for address) or left at numerous locations (see list
by state at the web site) - one such location is Wireless Zone, 7
North Route 31, Pennington, NJ. This is a tax deductible program and receipts will be provided.

While not equipment itself, polystyrene is used to pack many
electronics items (and eggs). The Alliance of Foam Packaging
Recyclers (http://www.epspackaging.org/) promotes the recycling
of expanded polystyrene, the white molded foam packing ‘blocks’
that accompany monitors, processors, DVD players, and other
electronic items. They have a clickable map by state to locate
cooperating companies. There are several in NJ but the closest
one to Trenton is: Raybob Packaging, 215-943-4799, Tullytown,
PA.
Household batteries, both rechargeable and non-rechargeable,
include varying types of toxic heavy metals: mercury, nickel,
zinc, lead, etc. These chemicals should be kept out of our landfills! In Mercer County batteries may be put at the curb for recycling as follows: Place the batteries in a clear plastic bag with a
“Zip-Lock” closure and seal the bag. Place the bag on top of
recyclables in the yellow bucket. PLEASE - do not put batteries
loose in the recycling bucket! This could be harmful to the people collecting and sorting recyclables. Household batteries may
also be brought to Household Chemical Waste Disposal Days or
dropped off at the following locations: Municipal Buildings,
County Administration Building, Yardville Supply, J&B Hill
(Hopewell Borough), and Radio Shack Stores. Look for blue
containers. More information on recycling in Mercer County
can be found at http://www.mcia-nj.com/recycling.html.
More information about recycling electronics in general, with
links to other local programs, is available at the National Recycling Coalition’s Electronics Recycling Initiative (http://
www.nrc-recycle.org/resources/electronics/).

The 2003
Nominations Are!
President ........................Clarke Walker
Vice President ................. Tom Carman
Secretary ................... Don Arrowsmith
Treasurer ................... Paul Kurivchack
Member-At-Large .............. Jon Abolins
Member-At-Large ...... Kim Goldenberg
Member-At-Large ................. Vic Laurie
Member-At-Large .................. Sol Libes
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PPCUG Member E-mail Directory
Name
Last

First

E-Mail
Address

Name
Last

First

E-Mail
Address

Abolins
Adler
Arrowsmith
Axelrod
Best
Bolge
Briggs
Budelis
Canavan
Caris
Carman
Castro
Chilton
Cohen
Colucci
Crossley
Davis
Dinkins-Belton
Dodge
Duggins
Edge, Jr.
Einthoven
Foulkes
Gibson
Goldenberg
Gunther
Hansen
Hardy
Hawryluk
Henry
Holly
Johnson
Juelch
Kerslake
Ketchel
Keinerman
Kleinerman
Konvalinka
Koosman

John D.
Seymour
Donald L.
Albert
John J.
Eleanor
George R.
Joseph
Thomas
Paul D.
Thomas
Carlos
Neal W.
Jon
Frank E.
Helen M.
Perry J.
Joyce
William B.
Marsha
Lewis A.
Bella
Frank
Dawson H.
Kim
Bruce W.
George
Wayne
Bill
Chuck
Lois
Florence
H. Karl
David
Joseph
Irma
Milton
John W.
Milton

jda-ir@njcc.com
syadler@aol.com
donaldarrowsmith@yahoo.com
aaxelrod@nerc.com
jjbest57@alum.mit.edu
embolge@jersey.net
grolbriggs@aol.com
Joe_Budelis@post.Harvard.edu
canavan1@aol.com
pcaris@earthlink.net
tom_carman@compuserve.com
carlos.castro@ieee.org
chilforce@aol.com
jon@njcc.com
DasWeb1@aol.com
CrossleyHM@aol.com
perrydavis@compuserve.com
Joyce8NJ@aol.com
b-mdodge@juno.com
msd@gfol.noaa.gov
lewis@edgeassoc.com
einthoven@mail.eclipse.net
ffoulkes1@aol.com
gibbygib@worldnet.att.net
kgolden3@optonline.net
bg1509@hotmail.com
gphansen5@yahoo.com
wayne99@att.net
bhawr@aol.com
chenry130@comcast.net
lois@audet.com
kredit@nerc.com
karljnj@nerc.com
AcuraOwner@aol.com
buddyjoe227@aol.com
rafiki@iopener.net
kukumafi@Juno.com
jkonvalinka@msn.com
miltonk2@aol.com

Krisak
Kurivchack
Landis
Laurie
Lazar
Lewis
Libes
Markward
Metzler
Middleton
Miller
Mintz
Montani
Mooney
Mosho
Oldenburg
Olson
Papier, Jr.
Phadke
Pitcher
Rothstein
Shinkfield
Sked
Stockwell
Suber
Tafel
Tayyabkhan
Walker
Tenner
Vanisko
Walthall
Weinberg
Weiss III
Williams
Willis
Willis
White

Bill
Paul
Houston E.
Vic
Joseph
Lloyd N.
Sol
Margaret
Joseph
Frank
Douglas E.
Herman
Linda
William P.
Martin
Thomas A.
Gaylord
Philip B.
Laxman G.
Barbara
Rick
David
Bill
Hunt
Michael J.
David E.
Mike
Clarke
Edward
Thomas L.
Ronald K.
Robert
Edward A.
Ken
Robert S.
Lloyd
Jonathan A.

BobKrisak@worldnet.att.net
kurivchp@optonline.net
judge@alumni.princeton.edu
hampsi@yahoo.com
joelazar@nerc.com
Budnorth@juno.com
sol@libes.com
mteragram@aol.com
76116.3117@compuserve.com
ftmprob@nerc.com
D.N.Miller@worldnet.att.net
hmintz4@aol.com
l.montani@worldnet.att.net
wmo8350722@aol.com
martinmosho@att.net
oldenburg-ta@worldnet.att.net
go@electrim.com
papierp@bellatlantic.net
lgphadke@comcast.net
bpitcher@ets.org
rich_web@email.com
d.shinkfield@worldnet.att.net
billsked@aol.com
hunt.stockwell@cornell.edu
mpsuber@juno.com
dtafel@comcast.net
tayyabkhan@aol.com
Clarke_Walker@compuserve.com
tenner@clarity.princeton.edu
tlvanisko@aol.com
ronwalthall@prodigy.net
bweinb@comcast.net
eweiss@nerc.com
krw1948@worldnet.att.net
rsw9999@cs.com
lwillis1@prodigy.net
jawhite@yes-llc.com
(Last Update: November 30, 2002)

Send Updates to kurivchp@optonline.net for inclusion in this listing.

Time to consider. . . continued from page 4

Consultants Corner

out. Notebooks, on average, have only about a fourth of the
longevity of a desktop.
Desktop or notebook is a common decision to be made.
Weigh the advantages and risks before purchasing either.

Meyda Online
“Meyda means Information”
J.D. Abolins
“Pro Bono” Educational Services
Specialties: Information Security, Privacy
Issues, and Web Publishing
http://www.meydabbs.com
E-mail: jda-ir@njcc.com

Ira Wilsker can be reached by email: ira@apcug.org
This article is brought to you by the Editorial Committee
of the Association of Personal Computer User Groups
(APCUG), an International organization to which this user
group belongs.

Consultants Corner
You can advertise your consulting business for $25 per year in
addition to your normal membership fee.
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Minutes for the General Meeting
November 18, 2002
By: Don Arrowsmith
Paul called the meeting to order at 7:46. Nominations for 2003 officers were announced for the election to be held at the
December meeting. Next year’s programs will include eBay, constructing PowerPoint presentations, and using batch files.
At 8:11 Karl Juelch began the evening’s program on Print Artist. This software is used to produce typical graphic projects for home
use such as newsletters, greeting cards, stationery, etc. It is similar to Print Shop or PrintMaster and more information can be found
at http://printartist.sierrahome.com/. Karl teaches a class on Print Artist at SeniorNet and brought a display with many items he has
made with this software. The evening concluded at 9:00.

Computing Factoids
Complied by: Steve Bass - Pasadena IBM Users Group

Listen Up and Take Heed!
I always tell people to unplug their PC when working on the insides. It’s something I never do. My unsolicited advice? Do it. All
the time.
Here’s why: I added a sound card to my wife’s PC the other day. Easy enough, right? Then, while the system was up and running,
I replaced the cover. I’ve done it that way since I started with PCs in 1983. This time it bit me on the butt. The case cover touched
an add-in card and the systemboard fried. Better it should have happened to my PC, you know what I’m saying? -Steve Bass
Steve Bass is a Contributing Editor with PC World and runs the Pasadena IBM Users Group. Check his Home Office columns at
http://snurl.com/homeoffice and sign up for the Steve Bass online newsletter at http://snurl.com/signup §
This article is brought to you by the Editorial Committee of the Association of Personal Computer User Groups (APCUG), an
International organization to which this user group belongs.

Holida
art
ions
Holidayy PPart
artyy & Elect
Elections
December 8, 2002
La
wrence Librar
Law
Libraryy
P.O Box 291
Rocky Hill, NJ 08553

Princeton PC Users Group

